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About This Document 
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an ACE supervisory controller. 
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Symbol Definitions 
The following table lists those symbols used in this document to denote certain conditions. 
 

Symbol Definition 
 

 
 

 
ATTENTION: Identifies information that requires special 
consideration.  

 

 

 
TIP: Identifies advice or hints for the user, often in terms of 
performing a task.  

 

 

 
REFERENCE -EXTERNAL: Identifies an additional source of 
information outside of the bookset.  

 

 

 
REFERENCE - INTERNAL: Identifies an additional source of 
information within the bookset.  

 
CAUTION 

 
Indicates a situation which, if not avoided, may result in equipment 
or work (data) on the system being damaged or lost, or may result in 
the inability to properly operate the process. 

  

 
 

 
CAUTION: Indicates a potentially hazardous situation which, if not 
avoided, may result in minor or moderate injury. It may also be used 
to alert against unsafe practices.  

CAUTION symbol on the equipment refers the user to the product 
manual for additional information. The symbol appears next to 
required information in the manual. 

 

 
 

 
WARNING: Indicates a potentially hazardous situation, which, if not 
avoided, could result in serious injury or death. 

WARNING symbol on the equipment refers the user to the product 
manual for additional information. The symbol appears next to 
required information in the manual. 
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Symbol Definition 
 

 
 

 
WARNING, Risk of electrical shock: Potential shock hazard where 
HAZARDOUS LIVE voltages greater than 30 Vrms, 42.4 Vpeak, or 
60 VDC may be accessible. 

 

 
 

 
ESD HAZARD: Danger of an electro-static discharge to which 
equipment may be sensitive. Observe precautions for handling 
electrostatic sensitive devices. 

 

 
 

 
Protective Earth (PE) terminal: Provided for connection of the 
protective earth (green or green/yellow) supply system conductor. 

 

 
 

 
Functional earth terminal: Used for non-safety purposes such as 
noise immunity improvement. NOTE: This connection shall be 
bonded to Protective Earth at the source of supply in accordance 
with national local electrical code requirements. 

 

 
 

 
Earth Ground: Functional earth connection. NOTE: This 
connection shall be bonded to Protective Earth at the source of 
supply in accordance with national and local electrical code 
requirements. 

 

 
 

 
Chassis Ground: Identifies a connection to the chassis or frame of 
the equipment shall be bonded to Protective Earth at the source of 
supply in accordance with national and local electrical code 
requirements. 
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Using OPC Gateway to Interface ACE to an OPC 
Server 

The OPC Gateway serves as a communication bridge between the Application Control 
Environment (ACE) and/or Simulation-Application Control Environment (SIM-ACE) 
supervisory controllers in an Experion system and an OPC server.  

The OPC Gateway supports OPC Data Access Standard versions 2.0 and 1.0. It does not 
support the OPC Alarms and Events or OPC Historical Data Access Standards. 

This book includes the following topics to help you apply and use the OPC Gateway 
function. If you are viewing this content online through Knowledge Builder, just click the 
topic title to jump to its location in the book. 

 
Topic 

Getting Started 

OPC Quick Reference 

Reviewing OPC Gateway Functional Characteristics 

OPC Data References 

OPC Data Type Conversions 

Creating OPC Gateway Block 

Enabling OPC Gateway Simulation Support 

Loading OPC Gateway Block 

Using Color Coded Icon to determine OPC Gateway status 

Changing State of OPC Gateway 

Monitoring OPC Gateway Status through Control Builder 

Migration Considerations 

Maintenance and Troubleshooting 
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Getting Started 
This section identifies the tasks that you need to complete to prepare the OPC Gateway 
for operation. The following table lists the tasks in the order that they are to be completed 
and includes a link to reference data, where applicable.  

 
Task Link or Reference 

Install and set up the OPC server.  See OPC server 
manufacturer’s 
documentation.  

Install the Experion R210 or greater software on the Experion Server.  See the Software 
Installation and 
Upgrade Guide.  

Install the Application Control Environment (ACE) software version R210 
or greater on the computer to be designated as the ACE node. You 
install the OPC Gateway executable with the ACE software.  

See the Software 
Installation and 
Upgrade Guide.  

Review OPC Gateway Configuration Guidelines Click Here 

Configuring ACE to Communicate with OPC Servers Click Here 
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OPC Gateway Configuration Guidelines 
• You install the OPC Gateway as part of the ACE software on an ACE computer.  

• In a system with only one ACE node, you must host the OPC Gateway on the ACE 
node. 

• In a system with more than one ACE node, we recommend that you host the OPC 
Gateway(s) on a single ACE node, reducing configuration work. You must configure 
each computer hosting an OPC Gateway for the proper DCOM security settings.  

• If the OPC server is on the same computer as an ACE, we recommend that you host 
the OPC Gateway on that ACE node to avoid DCOM configuration issues. 

• Each Experion Server can support up to ten (10) OPC Gateways.  

• Each OPC Gateway connects to one OPC server.  

• Each ACE node can support up to four (4) OPC Gateways.  

• ACE is the only supported peer environment to the OPC Gateway 

• Possible OPC Gateway configurations on ACE nodes, as shown in the following 
illustration, include, but are not limited to, the following.  

− Hosting four (4) OPC Gateways on one ACE node (Node 5 in illustration). This 
saves configuration time since only one node needs to be configured for DCOM 
communication with the OPC Server. 

− Hosting OPC Gateways on more than one ACE node (Nodes 4 and 5 in illustration). 

− Hosting one or more OPC Gateways on the same node as an ACE that will be 
communicating with them (Nodes 4 and 5 in illustration). 

− An ACE node communicating with one or more remote OPC Gateways on a single 
remote node (Node 3 to Node 5 in illustration).  

− An ACE node communicating with multiple OPC Gateways on multiple nodes 
(Node 2 to Nodes 4 and 5 in illustration. 

− An OPC Gateway responding to multiple ACE nodes (Node 5 to Nodes 1, 2, and 3 
in illustration). 

− Two OPC Gateways communicating with a single OPC Server (Nodes 4 and 5 to 
OPC 4 in illustration. 
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Figure 1  Multiple Gateways on Single ACE Node 
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Configuring ACE to Communicate with OPC Servers 
This section includes procedures for setting up the ACE node to enable OPC 
communication from the Control Data Access – supervisory platform (CDA-sp). 
Complete the procedures in the order presented.   

Configuring CDA-sp for OPC 
Use this procedure to set up a user account that CDA-sp can be run under.  

Prerequisites 
• You have installed ACE R210 or greater software.  

• You have logged on the ACE node with administrator privileges.  

Considerations 

For OPC communications, the account that CDA-sp runs under must be a user account 
that can be configured on several computers. 

 
Step Action 

1 Click the Start button, and then point to Settings and click Control Panel.  

2 In the Name column, double-click the Administrative Tools icon. 

3 In the Name column, double click the Services icon. 

4 • Scroll the open window to locate the Experion CDA-SP service in the 
Name column.   

• Double-click the Experion CDA-SP service. 

5 • Click the Log On tab.  

• Click the This Account option.  

• Click the Browse button  

• Scroll the list box to find mngr user in the Name column. 

• Click mngr and then click the OK button to return to the Log On tab.  

6 • In the Password field, type the mngr password.  
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Step Action 

• Press the Tab key.  

• In the Confirm Password field, type the mngr password again.  

• Click the Apply button.  

• Click the OK button.  

7 Acknowledge any informational messages that appear regarding permissions 
being granted to the mngr user account.  

8 Click the  close button to exit the Services dialog.  

9 On the Administrative Tools dialog, double-click the Local Security Policy 
icon. 

10 • On the Tree pane, click the  plus sign for Local Policies folder to 
expand its directory.  

• Click the User Rights Assignment folder.  

11 • In the Policy column on the View pane, double-click the Increase 
scheduling priority entry. 

• On the Local Security Policy Setting dialog, click the Add button.  

• On the Select Users or Groups dialog, scroll list box to locate mngr 
user in Name column.  

• Double-click the mngr user to add it to the second list box.  

• Click the OK button. 

• Click the OK button to close the Local Security Policy Settings dialog. 

12 • In the Policy column on the View pane, double-click the Lock pages in 
memory entry. 

• On the Local Security Policy Setting dialog, click the Add button.  

• On the Select Users or Groups dialog, scroll list box to locate mngr 
user in Name column.  

• Double-click the mngr user to add it to the second list box.  

• Click the OK button. 

• Click the OK button to close the Local Security Policy Settings dialog. 
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Step Action 

13 Click the  close button to exit the Local Security Settings dialog. 

14 On the File menu, click Close to exit the Administrative Tools dialog.  

15 This completes the procedure. Restart the computer for the changes to take 
effect.  

16 Go to the next procedure Adding OPC server account to ACE Node.  
 
Adding OPC server account to ACE Node 

For OPC communications to work properly, both the server computer and the client 
computer must be able to validate the necessary user names and passwords with each 
other as follows.  

• The server must validate the account under which the client runs. In this case, CDA-sp 
is the client, so sever needs to validate the mngr user account.  

• The client computer must validate the account under which the server runs. This is 
necessary for callbacks to function properly 

Prerequisites 

• You have completed the previous procedure Configuring CDA-sp for OPC.   

• You have logged on the ACE node with administrator privileges.  

Considerations 

The following procedure assumes that the OPC Server is a TPN Server (APP Node). The 
default account for the TPN Server component is TPSComServer and the password is 
password. If you are configuring a different OPC Server and/or your user name or 
password is different, be sure to substitute the correct account and password entries 
where necessary in the following procedure. 

 
Step Action 

1 On the desktop, right-click the My Computer icon and click Manage. 

2 • On the Tree pane, click the  plus sign for Local Users And Groups 
folder to expand its directory. 

• Right-click the Users folder and click New User to open the New User 
dialog.  
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Step Action 

3 • In the User Name field, type the server account name. For example, 
type TPSComServer for a TPN Server. Press the Tab key. 

• In the Full Name field, press the Tab key to skip this entry or type 
desired full name and then press the Tab key. 

• In the Description field, type desired descriptive text and then press the 
Tab key. 

• In the Password field, type the account password. For example, type 
password for a TPN Server default TPSComServer account. Press the 
Tab key.  

• In the Confirm Password field, type the account password again. 
Press the Tab key.  

• Click the User must change password at next logon check box to 
clear it.  

• Click the User cannot change password check box to select it.  

• Click the Password never expires check box to select it.  

• Click the Create button.  

• Click the Close button.  

4 Click the  close button to exit the Computer Management dialog. 

5 This completes the procedure. Go to the next procedure Preventing local 
logon of OPC server account to ACE node.  

 
Preventing local logon of OPC server account to ACE node 

Once you create an OPC server account on the ACE node, the next step is to prevent that 
account from being used to log on at the keyboard. This is done for security reasons. 

Prerequisites 

• You have completed the previous procedure Adding OPC Server Account to ACE 
Node.   

• You have logged on the ACE node with administrator privileges.  
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Considerations 

The following procedure assumes that the OPC Server is a TPN Server (APP Node). The 
default account for the TPN Server component is TPSComServer and the password is 
password. If you are configuring a different OPC Server and/or your user name or 
password is different, be sure to substitute the correct account and password entries 
where necessary in the following procedure. 

 
Step Action 

1 Click the Start button, and then point to Settings and click Control Panel.  

2 In the Name column, double-click the Administrative Tools icon. 

3 On the Administrative Tools dialog, double-click the Local Security Policy 
icon. 

4 • On the Tree pane, click the  plus sign for Local Policies folder to 
expand its directory.  

Click the User Rights Assignment folder.  

5 • In the Policy column on the View pane, double-click the Deny logon 
locally entry. 

• On the Local Security Policy Setting dialog, click the Add button.  

• On the Select Users or Groups dialog, confirm that the local computer 
is listed in the Look in field. If it is not listed, click the arrow button in the 
field and select it from the list.  

• Scroll the list box to locate TPSComServer user in the Name column.  

• Double-click the TPSComServer user to add it to the second list box.  

• Click the OK button. 

5 Click the  close button to exit the Local Security Policy Settings dialog.  

6 On the File menu, click Close to exit the Administrative Tools dialog.  

7 This completes the procedure. Restart the computer for the changes to take 
effect.  

8 Go to the next procedure Adding mngr user account to OPC server node.  
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Adding mngr user account to OPC server node 
For OPC communication to work properly there must be authentication from client to 
server and also from server back to client. Adding the TPSComServer account to the 
ACE Node with the same password as the TPSComServer account on the OPC Server 
node allowed authentication from server. 

The procedure in this section allows authentication from the client to the server.  

Prerequisites 

• You have completed the previous procedure Preventing local logon of OPC server 
account to ACE node.   

• You have logged on the OPC server node with administrator privileges.  

Considerations 

Be sure you are working on the OPC server node.   
 

Step Action 

1 On the desktop, right-click the My Computer icon and click Manage. 

2 • On the Tree pane, click the  plus sign for Local Users And Groups 
folder to expand its directory. 

• Right-click the Users folder and click New User to open the New User 
dialog.  

3 • In the User Name field, type mngr as the server account name. Press 
the Tab key. 

• In the Full Name field, press the Tab key to skip this entry or type 
desired full name and then press the Tab key. 

• In the Description field, type desired descriptive text and then press the 
Tab key. 

• In the Password field, type the mngr account password. This password 
must be the same as the one used for the mngr account on the ACE 
node.  

• In the Confirm Password field, type the account password again. 
Press the Tab key.  

• Click the User must change password at next logon check box to 
clear it.  
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Step Action 

• Click the User cannot change password check box to select it.  

• Click the Password never expires check box to select it.  

• Click the Create button.  

• Click the Close button.  

4 On the Tree pane under the Local Users and Groups directory, click the  
Users folder. 

5 On the View pane, double-click the mngr account in the Name column.  

6 On mngr Properties dialog, click the Member Of tab. 

Click the Add button.  

On the Select Groups dialog, double-click the Administrators group in the 
top list box to add it to the second list box.  

Click the OK button. 

7 Confirm that Administrators group now appears in the list box on the 
Member Of tab and click the OK button to close the mngr Properties dialog. 

8 Click the  close button to exit the Computer Management dialog. 

9 This completes the procedure. Go to the next procedure Adding mngr to OPC 
server permissions.  
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Adding mngr to OPC server permissions 

Once you add the mngr account to the OPC server computer you must configure the 
OPC server component so that mngr has permissions to launch, access, and configure the 
OPC server. The OPC communication may not function properly without these 
permissions. 

Prerequisites 

• You have completed the previous procedure Adding mngr user account to OPC server 
node.   

• You have logged on the OPC server node with administrator privileges.  

Considerations 

• This procedure assumes that the OPC server is a TPN server (APP Node). The name 
for the TPN server component in the DCOM Configuration Utility is HCI_TPNServer 
– exe Server. If you are configuring a different OPC server and/or the name for the 
OPC server component is different, be sure you substitute the correct name where 
necessary in the following procedure. 

• If the TPN server has System Management software, the launch and configuration 
permissions set in Steps 6 and 7 of the following procedure should be handled by the 
System Management configuration.   

• Note that this configuration is installed with workstation security. See the Using High 
Security Policy section in the Server and Client Configuration Guide for more 
information.  

 
Step Action 

1 Click the Start button and click Run.   

2 In the Open field, type dcomcnfg. Click the OK button.  

3 On Distributed COM Configuration Properties dialog, scroll list box on the 
Applications tab to find the HCI_TPNServer – exe Server entry. 

4 Click HCI_TPNServer – exe Server in list and click the Properties button.  

5 On HCI_TPNServer – exe Server Properties dialog, click the Security tab. 

• Click the option Use Custom Access Permissions. 

• Click the Edit button. 
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Step Action 

• On the Registry Value Permissions dialog, click the Add button.  

• On the Add Users and Groups dialog, be sure the local computer is 
listed in the List Names From field. If it is not listed, click the arrow 
button in the field and select it from the list.  

• Click the Show Users button.  

• Scroll the Names box to find the mngr user account. Double-click the 
mngr entry to add it to the Add Names box.  

• Check that Allow Access appears in the Type of Access field. If it 
does not, click the arrow button in the field and select it from the list.  

• Click the OK button to close the Add Users and Groups dialog.  

• Click the OK button to close the Registry Value Permissions dialog.  

6 On the Security tab, click Use custom launch permissions.  

• Click the Edit button. 

• On the Registry Value Permissions dialog, click the Add button. 

• On the Add Users and Groups dialog, be sure the local computer is 
listed in the List Names From field. If it is not listed, click the arrow 
button in the field and select it from the list.  

• Click the Show Users button.  

• Scroll the Names box to find the mngr user account. Double-click the 
mngr entry to add it to the Add Names box.  

• Check that Allow Access appears in the Type of Access field. If it 
does not, click the arrow button in the field and select it from the list.  

• Click the OK button to close the Add Users and Groups dialog.  

• Click the OK button to close the Registry Value Permissions dialog.  

7 On the Security tab, click Use custom configuration permissions.  

• Click the Edit button. 

• On the Registry Key Permissions dialog, click the Add button. 

• On the Add Users and Groups dialog, be sure the local computer is 
listed in the List Names From field. If it is not listed, click the arrow 
button in the field and select it from the list.  
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Step Action 

• Click the Show Users button.  

• Scroll the Names box to find the mngr user account. Double-click the 
mngr entry to add it to the Add Names box.  

• Check that Full Control appears in the Type of Access field. If it does 
not, click the arrow button in the field and select it from the list.  

• Click the OK button to close the Add Users and Groups dialog.  

Click the OK button to close the Registry Key Permissions dialog.  

8 • On HCI_TPNServer – exe Server Properties dialog, click the Apply 
button.  

• Click the OK button to close the dialog.  

9 Click the OK button to close the Distributed COM Configuration Properties 
dialog. 

10 This completes the procedure. 
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OPC Quick Reference 
OPC provides data from a data source and communicates the data to any client 
application in a standard way. This assures interoperability by eliminating the 
requirement for an application to have specific knowledge about a particular data source, 
such as internal structure and communications protocols.  

An OPC server and an OPC client can reside either on the same computer (local server) 
or on different computers (remote server).  

Description of some OPC related Terms 
 

Term Description 

CLSID The class identifier that identifies an object. An object registers its 
CLSID in the system registration database so the object can be 
loaded and programmed by other applications. 

COM Stands for the Component Object Model. It is a collection of 
services that let software components interoperate in a networked 
environment.  

DCOM Stands for Distributed Component Object Model. It is a protocol 
that enables software components to communicate directly over a 
network. DCOM is designed for use across multiple network 
transports, including Internet protocols such as HTTP.  

group A number of items with the same update rate and deadband.  

item A single data source of the OPC server.  

OLE Stands for Object Linking and Embedding – a Microsoft technology. 

OPC Stands for OLE for Process Control. It is a set of standards that 
define sets of COM interfaces (based on Microsoft's COM/OLE 
technology) to be observed by OPC clients and servers. This set of 
standards was established by the OPC Foundation to foster 
greater interoperability between automation and control 
applications, field systems and devices, and business and office 
applications. When the term OPC is used in this Reference, it 
refers specifically to the OPC Data Access Standard. 

ProgID A programmatic identifier. A registry entry that can be associated 
with a class identifier (CLSID). The format of a ProgID is 
<Vendor>.<Component>.<Version>, separated by 
periods and with no spaces. The ProgID identifies a class, but with 
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Term Description 
less precision. The ProgID is used to identify the OPC server from 
other COM/DCOM components on the same computer. For more 
details, see any setup and installation instructions provided by the 
OPC server manufacturer.  

update rate The internal update rate of the items in the OPC Server 
 
About OPC data transfer 

OPC server data is available to the OPC client as items. To receive items from the OPC 
server, the OPC client must gather one or more items into a group.  

The OPC client requests the OPC server to create a group with a client-specified 
maximum (at most) update rate and a deadband. The OPC client then requests the OPC 
server to add items to the group. The update rate and the deadband of a group apply to all 
items in that group.  

When working with OPC data, remember the following two things: 

• There is no concept of hardware in the OPC Data Access Standard; there are just 
items. An OPC server may represent a piece of hardware as an item and the item's 
value may indicate the state of the hardware. However, whether or not such 
representation is available is server-specific.  

• Although the OPC client can specify any update rate for a group, the OPC server 
decides whether the request is honored.  

Callback function 
Generally, the OPC server sends data to OPC clients through callbacks. Once a group is 
created, the OPC server creates a cache for the group items. The cache is updated 
according to the group's update rate. The OPC server sends only updated values to the 
OPC client for items in the group if there has been significant change since the last cache 
update (based on the group's deadband).  

This method of data update significantly reduces traffic between the OPC client and the 
OPC server as there is no need for periodic read requests to the OPC server. An OPC 
client gets data when there is a significant change. The OPC client defines the level of 
change required to trigger an update from the OPC server.  
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Synchronous read request action 
 

 
ATTENTION 

Since synchronous read requests are blocking operations, the OPC Gateway 
does not do synchronous reads in order to preserve determinism.  

 
The OPC client can also send synchronous read requests to the OPC server, independent 
of the server callbacks. The OPC client specifies whether the data should come from the 
OPC server's internal cache or from the field/hardware device. This method of scanning 
is less efficient than callback.  

Reviewing OPC Gateway Functional Characteristics 
The OPC Gateway operates as a bridge/translator between the Control Data Access 
(CDA) communications protocol in the Experion system and the standardized OPC 
communications protocol in the OPC server. It converts CDA handles to OPC parameter 
names and makes the appropriate requests (reads/writes).  

The OPC Gateway depends on the CDA-supervisory platform (CDA-sp) for its 
communications link to the rest of the Experion system, but it runs in its own process 
space as shown in the following figure.  

 

  
Figure 2  OPC Gateway Functional Architecture 
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OPC connectivity 

The OPC Gateway provides a single point of connectivity to an OPC Server regardless of 
how many controllers have peer references to that OPC server. All ACE and SIM-ACE 
controllers share a single instance of the OPC Gateway, so there is only one set of OPC 
connections to the OPC server, as shown in following figure. 

 

 
 

Figure 3  Multiple Controllers and Single OPC connection 
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OPC redundancy support 

You can use an intermediate OPC server, such as the Honeywell Transparent Redirection 
Manager, to provide redundancy from the OPC Gateway to the OPC server as shown in 
the following illustration.  

 

 
 

Figure 4  Redundancy Support Through Redirection Manager 

Status monitoring and reporting 

The OPC Gateway can monitor and report its own status, the status of the 
communications with the target OPC server, and various other communications related 
statistics, such as CDA peer/display statistics, that other supervisory controllers provide. 
It can issue alarms and notifications through the following common system venues. 

• Color changes in block icons on the Monitoring tab 

• Alarm Summary display in Station 

• Event Summary display in Station 

• Error messages 

• Error handling log files 

• Applicable tabs on the block’s Parameters form in the Monitoring mode.  
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OPC Data References 
OPC Data Name Syntax 

Use the following naming syntax to identify the data of interest in the OPC server.  

<OPC Gateway function block name>.<OPC server data specific name> 

For example, you configure an OPC Gateway block in Control Builder with the name 
OPC1 and you want to access data named InterlockA.Active in the configured OPC 
server. You would format the correct reference to this data as follows: 

OPC1.InterlockA.Active 

Parameter connectors or Parameter References 
Since an OPC server block cannot be contained in a Control Module (CM), you must use 
parameter connectors to route OPC server data elements to applicable native block 
connections or to read/write parameter references for CAB instances in the control 
strategy . The following figure shows two parameter connectors being used to connect 
data elements named InterlockA.Active and InterlockB.Active from the configured OPC 
Gateway named OPC1 to inputs 1 and 2 of an AND function block in a Control Module 
named CM865 for reference. This strategy is only valid if loaded to an ACE/CEE 
environment.  
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REFERENCE - INTERNAL 

Please refer to the Custom Alogrithm Block and Custom Data Block User’s 
Guide for more information about >parameter references. 

 
OPC references in expressions 

You configure OPC data references in SCM Step Output, SCM Transition, AUXCALC 
block, or REGCALC block the same as other system parameters using the valid naming 
syntax for the OPC data elements. The following figure shows a SCM Step Output 
expression used to read the "Count.PV" data from an OPC Gateway named OPC2, add 
1.0 to the read value, and store the new value to the Count.PV data in OPC2.  
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OPC references in SCM Alias table 
Use the following guidelines to configure OPC data references in the Aliases table for a 
SCM block.  

• Choose the OPC Gateway block as the Model Block for the given Alias.  

• Choose either the External Reference (EXTREF) or the External Reference Structure 
(EXTREFSTRUCT) parameters of the OPC Gateway block for the given Alias.  

− For an Alias with the EXTREF parameter, the instance references can be references 
to either OPC Gateway data or FLOAT64 type system Server data.  

− For an Alias with the EXTRETSTRUCT parameter, the instance references can be 
references to either the OPC Gateway data or EXTREF_STRUCT type system 
Server data.  

The following figure shows a sample reference to OPC Gateway data in a SCM Aliases 
table. The first alias is for an OPC Gateway block with an EXTREF parameter for an 
Instance 1 data reference from an OPC Gateway named OPC46. The second alias is for a 
Numeric block with a PV parameter for an Instance 1 data reference from a Numeric 
block named n1 in a Control Module named cm42.  
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OPC Data Type Conversions 
About data type 

Since the data type of the OPC server data reference is not known at configuration time, 
it is possible that the actual data type accessed at run time will not match the data type 
expected by the control strategy in the ACE controller. Please review the following 
sections for a summary of the guidelines covering data type conversions for OPC data 
Gets and Stores.   

Gets conversions 
The ACE controller receives the actual OPC data type for "gets" at run time and 
translates the value into a system data type based on the following translation table.  

 

 
TIP 

• For a Whole Array Transfer, the OPC Vartype is the variant type of the 
individual array elements ORed with the VT_ARRAY type. In the case of 
an EXTREF_STRUCT (used in the UCNOUT function block), the OPC 
Vartype is VT_VARIANT ORed with VT_ARRAY. 

• For DELTATIME parameter considerations, see the Time Support in 
Experion System section in the Control Builder Components Theory book.  

  
If OPC VARTYPE Is . . .  Then, System Data Type Is . . .  

VT_BOOL BOOL 

VT_UI1 UINT8 

VT_UI2 UINT16 

VT_UI4 UINT32 

VT_UI8 UINT64 

VT_I1 INT8 

VT_I2 INT16 

VT_I4 INT32 

VT_I8 INT64 

VT_R4 FLOAT32 
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If OPC VARTYPE Is . . .  Then, System Data Type Is . . .  

VT_R8 FLOAT64 

VT_BSTR STRING 

VT_FILETIME TIME 

VT_ARRAY 

VT_BLOB 

EXTREF_STRUCT 

Other VT_ data types Bad Value Status 
 

The general translation scenario is as follows.  

• The CDA-sp performs the interface specific translation of external reference type to 
system type.  

• The system value status is set according to the quality bit field of the OPC item state 
quality.  

• The sub status and limits bit fields of the OPC item are ignored.  

• The OPC array and blob variant types are forced into a system External reference 
structure type to distinguish them from internal system structures. A specific purpose 
function block, such as the UCNOUT block, is required to use an External reference 
structure type.  

• The OPC variant types that are not supported result in a data type mismatch error.  

• The CDA-sp delivers a system value to the appropriate function block.  

• When the data types do not match, the function block receiving the data makes an 
attempt to convert between the actual and expected data types.  
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General data conversion considerations 

The following table shows the data type conversions that the system does or does not 
support. A Yes means that the conversion is supported or not required, when the data 
types match, and a No means that the data type conversion is not supported.  

 
From 

To 

BOOL UINT8 
UINT16 
UINT32 

UINT 
64 

INT8 
INT16 
INT32 

INT 
64 

ENUM 
SD_ENUM 

FLOAT 
32 
FLOAT 
64 

STRING TIME 

BOOL Yes Yes Yes Yes Yes Yes Yes No No 

UINT8 Yes Yes Yes Yes Yes Yes Yes No No 

UINT16 Yes Yes Yes Yes Yes Yes Yes No No 

UINT32 Yes Yes Yes Yes Yes Yes Yes No No 

UINT64 Yes Yes Yes Yes Yes Yes Yes No No 

INT8 Yes Yes Yes Yes Yes Yes Yes No No 

INT16 Yes Yes Yes Yes Yes Yes Yes No No 

INT32 Yes Yes Yes Yes Yes Yes Yes No No 

INT64 Yes Yes Yes Yes Yes Yes Yes No No 

FLOAT 
32 

Yes Yes Yes Yes Yes Yes Yes No No 

FLOAT 
64 

Yes Yes Yes Yes Yes Yes Yes No No 

STRING No No No No No No No Yes No 

TIME No No No No Yes No No No Yes 

EXTRE
F_STR
UCT 

No No No No No No No No No 

 
Keep the following considerations in mind when dealing with data conversions.  

• Be aware that downcasting occurs when conversions involve a type that supports a 
wider range of values to a type with a more narrow range of values.  
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− For example, an INIT16 value of 333 is converted to UNIT8 value of 255.  

− For example, an INT32 value of 100,000 is converted to the maximum Enumeration 
value of 65,535. The function block that receives the Enumeration ordinal of 65,535 
will likely reject this value, since it is out of range for the applicable Enumeration 
parameter. This is consistent with the current behavior where an out of range store 
to an Enumeration parameter does not cause the destination parameter to assume the 
failsafe value.  

− For example, an OPC server data type of Integer is connected to a PID block's 
MODE parameter. If the Integer value is 7 at run time, the MODE parameter rejects 
the value because it is outside the MODE enumeration range of 0 to 5.  

• Float to integer conversions use truncation instead of rounding. For example, a Float 
of 3.75 is converted to the Integer 3.  

• The underlying type for system Boolean values is unsigned character. Since the 
underlying type for Boolean external references cannot be assumed, all external 
Boolean references are converted in the context of the system, which uses 0 for False 
and 1 for True. For example: 

− Boolean True converts to Integer 1 or Float 1.0 

− Boolean False converts to Integer 0 or Float 0.0 

− Integer 7 converts to Boolean True  

− Integer 0 converts to Boolean False  

− Integer –336 converts to Boolean True  

− Float 33.33 converts to Boolean True  

− Float –0.567 converts to Boolean True  

− Float 0.0 converts to Boolean False  

− Float 0.0001 converts to Boolean True (Similar to expressions, no threshold value is 
used in the test for zero. The TypeConvert block does provide a threshold for Float 
compares to zero, so use this block when this conversion is a concern.) 

− Enumeration ordinal 0 converts to Boolean False  

− Enumeration ordinal 8 converts to Boolean True  

− Float 5.82 converts to Enumeration ordinal 5 

− Float –11.0 converts to Enumeration ordinal 0 
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• Conversions between Strings and Integers and between Strings and Floats are not 
supported 

The following table summarizes the failsafe data value that is substituted when a given 
data type conversion is not supported.  

 
If Data Type Is . . .  Then, Failsafe Value Is . . .  

BOOL Off 

UINT8 
UINT16 
UINT32 
UINT64 

0 

INT8 
INT16 
INT32 
INT64 

0 

ENUM 
SD_ENUM 

Ordinal value of 0 

FLOAT32 
FLOAT64 

NaN 

STRING Blank 

TIME 0 

EXTREF_STRUCT Bad Status 
 

For example, if the OPC1.InterlockA.Active parameter used as the input to an AND 
block in the previous figure in section Parameter connectors only returns a Boolean, 
Integer, or Float data type at run time, the appropriate conversion is made and the data 
get is completed successfully. If the OPC1.InterlockA.Active parameter returns a String 
data type, the Boolean failsafe value of Off is applied to the AND block input.  

Stores conversions 
The CDA-sp receives the store value from the initiating function block and converts it as 
needed before storing the value to the OPC server. The CDA-sp executes a one time read 
of the value from the OPC server to learn its actual data type before initiating the Store.  

The ACE supervisory controller supports the UCNOUT block, PUSH block, and SCM 
Step Output expressions for initiating stores to the OPC server.  
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Creating OPC Gateway Block 
Use the following procedure to create an OPC Gateway block to represent the OPC 
Gateway software installed on an ACE node in the Project tab of Control Builder.  

Prerequisites 
You have installed R210 software or greater on your Experion Server.  

You have logged on with sufficient privileges required to configure a control strategy in 
Control Builder.  

You have configured assets through the Enterprise Model Builder.  

You have launched Control Builder through Configuration Studio.  

Considerations 
• You have used Control Builder before to create function blocks in the Project tab.  

• You know what the Internet Protocol (IP) addresses are for the computers hosting the 
OPC Gateway and the OPC server.  

• You can use the names for the computers hosting the OPC Gateway and the OPC 
server and let the system resolve the names into IP addresses. However, using the IP 
address results in a more robust configuration and minimizes the possibility of many 
error conditions occurring. 

• You know what the PROGID is for the OPC server that is to communicate with the 
OPC Gateway. 

 
Step Action 

1 On the File menu, click New>External Servers>OPC - OPC Gateway 

2 In the Tag Name field, type a unique name for the block or accept the default 
name. Press the Tab key.  

3 In the Item Name field, type the name of the Entity that this node will be 
associated with in the Enterprise Model Builder hierarchy 

4 In the OPC Gateway Location Host IP Address field, type the IP address for 
the computer hosting the OPC Gateway function. Press the Tab Key. 

5 In the OPC Gateway Location Host Name field, check that the name of the 
computer is correct for the entered IP Address. The name should be entered 
automatically, if the Server is connected to the ACE node containing the OPC 
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Step Action 
Gateway. If not, type the name of the host computer. Press the Tab key. 

6 In the OPC Server Host IP Address field, type the IP address for the 
computer hosting the OPC Server that is communicating through this OPC 
Gateway. Press the Tab Key. 

7 In the OPC Server Host Name field, check that the name of the computer is 
correct for the entered IP Address. The name should be entered 
automatically, if the Server is connected to the ACE node containing the OPC 
Gateway that is connected to the OPC server. If not, type the name of the 
host computer. Press the Tab key. 

8 In the OPC Server PROGID field, type the PROGID for the named OPC 
Server.  

9 Click the Alarming Enabled check box to select (enable) the option. Or, 
clear the check box to disable the option.  

10 Click the Alarming JOURNAL ONLY check box to select (enable) the option. 
Or, clear the check box to disable the option 

11 Click the Convert Time Values to UTC check box to select (enable) the 
option. Or, clear the check box to disable the option.  

12 Click the remaining tabs in succession and click the Help button for more 
information about a parameter entry field on a given tab.  

13 Click the OK button to close the OPC Block Parameters form and save your 
configuration entries.  

14 Check that the icon for the OPC Gateway block now appears in the Project 
tab. For example:  

 

 
 

15 This completes the procedure.  
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Enabling OPC Gateway Simulation Support 
Prerequisites 

• You have logged on with sufficient privileges required to configure a control strategy 
in Control Builder.  

• You have launched Control Builder through Configuration Studio.  

• You have created an OPC Gateway block.   

Considerations 
• The OPC Gateway supports simulation by allowing a SIM-ACE to interact with any 

OPC Server as if it were a simulation node. We use the term On Process to refer to a 
non-simulation node. The following table outlines the rules for interaction of OPC 
Gateway in a given simulation mode.  

 
ACE Simulation 

State 
OPC Gateway 

Simulation State 
Result 

On Process On Process ACE can read and write to the OPC Gateway 

Simulation On Process ACE can read from the OPC Gateway. Writes 
will be marked successful but will not be 
processed by the OPC Gateway. 

On Process Simulation ACE can write to the OPC Gateway. Reads 
from the OPC Gateway will be marked as 
failed and the value returned will be a fail-safe 
value. 

Simulation Simulation ACE can read and write to the OPC Gateway 
 

• The Simulation Enable (SIMENABLE) parameter is a configuration only parameter 
that can only be changed at load time.  

• If the OPC Gateway is loaded and running, you must shut it down for it to accept a 
change to the SIMENABLE parameter.  
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To enable OPC Gateway simulation 
 

Step Action 

1 In the Project tab of Control Builder, double-click the OPC Gateway block 
icon to call up its configuration form.  

2 Click the check box for the Simulation Enable (SIMENABLE) parameter to 
select it.  

3 Click the OK button to save the change and close the OPC Block 
configuration form.  

4 Right-click the OPC Gateway block icon and select Load from the shortcut 
menu to initiate a configuration load to the server. See the next section for 
more information about loading.  

5 In the Monitoring tab, double-click the OPC Gateway icon to call up its 
configuration form.  

6 Click the down arrow in the Gateway Command box and select RUN from 
the list. Click the OK button to acknowledge the change.  

7 Click the OK button to close the OPC Block configuration form.  

8 This completes the procedure. Go to the next section.  
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Loading OPC Gateway Block 
Use the following procedure to load an OPC Gateway block to its host computer. 

Prerequisites 
• You have created an OPC Gateway block as outlined in the previous section.  

• You have installed the OPC Gateway executable on the host computer.   

• You have made the network medium connections.  

Considerations 

• You can right-click the OPC Gateway block icon and select Load from the shortcut 

menu or just click the Load  button in the toolbar with the block selected, as 
alternate methods to open the Load Dialog.  

• Control Builder does not validate the addresses for the hosting computers when the 
OPC Gateway block is configured. If you configure an invalid address for the OPC 
Gateway host computer, the OPC Gateway block will fail to load and Control Builder 
will generate the appropriate error message during load. If you configure an invalid 
address for the OPC server host computer, the OPC Gateway block will load but it will 
report a communications error when trying to establish connections to the OPC server. 

• If any load error is detected, it is best to resolve the error before continuing with the 
load.  

• The OPC Gateway has a fixed 2-second execution cycle after it is loaded. The 
execution cycle is just for calculating statistics and polling for incoming requests from 
CDA. It does not have any implications for determinism within the OPC Gateway. 
Communications between the OPC Gateway and the OPC server are not bound by an 
execution cycle. 

• The following procedure assumes that this is the initial load of an OPC Gateway 
block. The procedure for a re-load is similar but the loaded OPC Gateway must be in 
its Idle state and the data fields on the Load dialog will reflect current operation 
status.  
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Step Action 

1 On the Controller menu, click Load.  

2 On the Load Dialog, be sure the check box in the Load column is selected, 
the name of the OPC Gateway block appears in the Load List column, Not 
Loaded appears in the Current State column for initial block load, N/A 
appears in the State to Load column, and N/A appears in the Post Load 
State column 

3 Click the OK button.  

4 Monitor load progress through the Load dialog. Any detected load errors will 
appear in the Errors list box on the dialog.  

5 Once the load completes, click the Monitoring tab to view the loaded OPC 
Gateway block icon.  

6 This completes the procedure.  
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Using Color Coded Icon to determine OPC Gateway status 
The following table defines the state of the OPC Gateway based on the color of its block 
icon in the Monitoring tab.  

 
If Icon Appears 

Like This. . .  
Then, State Name Is. . . And, It Means This. . .  

 
Unable To Determine 
State 

Control Builder is unable to get state 
information for the OPC Gateway from CDA 
Server. This is typical of a CDA Server failure. 

 
Idle The OPC Gateway is loaded and ready to be 

put into the active state. The connection with 
the OPC Server is not open. Store requests 
received in this state will be marked as 
StoreFailed and fetch requests will be marked 
with a bad status and set to failsafe values. 

 
Loaded But Not 
Available 

The OPC Gateway has been loaded but the 
executable (opcgtwy.exe) is not running. This 
is typical if the execution program fails but 
CDA-sp remains active. 

 
No Communication The OPC Gateway node is not communicating 

with the CDA Server. This is typical if CDA-sp 
(and possibly the OPC Gateway execution 
program as well) has failed or stopped running. 

 
Active The OPC Gateway is active and processing 

data. 

 
OPC Communications 
Error 

Need to alert the operator that some OPC 
communications error has occurred at the OPC 
Gateway. 
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Changing State of OPC Gateway 
The following table summarizes how to change the state of the OPC Gateway through 
the loaded OPC Gateway block in the Monitoring tab of Control Builder. You can also 
make the same changes though the Detail Display for the OPC Gateway in Station  

 
If Current State Is. . .  And You Want to 

Change State to. . . 
Then, Do This. . .  

Idle   Active   Click OPC Gateway icon in Monitoring tab. 
On the Runtime menu, Click 
Activate>Selected Item(s).  

Active   Idle   Click OPC Gateway icon in Monitoring tab. 
On the Runtime menu, Click 
Inactivate>Selected Item(s).  

  

Monitoring OPC Gateway Status through Control Builder 
The Parameters form for the OPC Gateway block includes various tabs that provide 
access to parameters for configuration through the Project tab and for monitoring 
through the Monitoring tab. Use the following procedure to access the Parameters form 
for a loaded OPC Gateway block in the Monitoring tab. This procedure assumes that 
you have logged on to Control Builder and have loaded your control strategy to the 
controller.  

Prerequisites 
• You have launched Control Builder through Configuration Studio.  

• You have loaded the OPC Gateway block to the ACE node.  

Considerations 
• You can only view OPC Gateway blocks in Monitoring tab set for the Assignment 

view. The Assignment view shows the relationship among all blocks while the 
Containment view only shows templates that contain other templates or Control 
Modules (CM), Sequential Control Modules, (SCM) and basic blocks. To toggle the 
view, right-click in an open area of the tab window and select Assignment View or 
Containment View from the shortcut menu, as applicable.  
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• You can right-click the OPC Gateway block icon and select Module Properties from 
the shortcut menu or on the Edit menu, click Module Properties with the block 
selected, as alternate methods to open the Parameters form.  

 
Step Action 

1 In Control Builder, click the Monitoring tab.  

2 Double-click the OPC Gateway block icon.  

3 On the OPC Block Parameters form, click the tab you want to view. The 
Main tab opens by default.  

4 Repeat Step 3 to view other tabs, as desired.  

5 When finished viewing, click the OK button.  

6 This completes the procedure.  
  

 
REFERENCE - INTERNAL 

Refer to the Control Builder Parameter Reference for more details on a given 
parameter.  

 
Viewing Main tab 

The following table summarizes the parameter data you can monitor on the Main tab of 
the Parameters form for the selected OPC Gateway block. See Monitoring OPC 
Gateway Status through Control Builder for details on accessing the OPC block 
Parameters form Main tab through the Monitoring tab.  

 
Plain Text Parameter Name User 

Configurable  
Notes 

Tag Name NAME Project Only  System assigned or user 
configured unique name. 
Consisting of up to 16 
characters and at lease one 
character must be a letter 
(A-Z).  
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Plain Text Parameter Name User 
Configurable  

Notes 

Item Name  ITEMNAME Project Only The name of the item that 
this object will be 
associated with in the 
Enterprise Model Builder 
hierarchy. The name can 
be up to 40 characters long 
and at least one character 
must be a letter (A-Z). 

Host IP Address GWHOSTIPPRI Project Only Defines host computer IP 
address for OPC server. 
Valid IP address entry 
results in the system 
automatically determining 
the Host Name, when given 
node is online.  

Host Name GWHOSTNAMEP
RI 

Project Only Defines host computer 
name for OPC server. Valid 
host name entry results in 
the system automatically 
determining the IP address, 
when given node is online.  

OPC Server Host IP 
Address 

 HOSTIPPRI Project Only Defines host computer IP 
address for OPC Gateway. 
Valid IP address entry 
results in the system 
automatically determining 
the Host Name, when given 
node is online.  

OPC Server Host 
Name 

HOSTNAMEPRI Project Only Defines host computer 
name for OPC Gateway. 
Valid host name entry 
results in the system 
automatically determining 
the IP address, when given 
node is online.  

OPC Server PROGID PROGID Project Only Defines the Microsoft COM 
object Program ID for the 
intended OPC server.  
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Plain Text Parameter Name User 
Configurable  

Notes 

Gateway Command GWCOMMAND Monitoring Only Lets user issue applicable 
command to the OPC 
Gateway executable.  

Gateway State GWOPCGSTATE No The current state of the 
OPC Gateway (Idle, Active, 
etc.) 

In-Alarm Flag INALM No Shows current status of in-
alarm flag. 

Alarming Enabled ALMENBSTATE Project Only Lets user enable or disable 
alarming option for block.  

Alarming JOURNAL 
ONLY 

JOURNALONLY Project Only Lets you specify if alarms 
are to be sent to the 
Jounral only.  

Convert Time Values 
to UTC 

GWUTCCONVER
T 

Yes Lets you specify if OPC 
Gateway is to convert all 
VT_DATE variable types to 
UTC time. 

Server State GWOPCSRVSTA
TE 

No Shows current state of the 
OPC server.  

HCI Capability GWHCIFLAG No Shows whether HCI is On 
or Off. 

OPC Version in Use GWOPCVERSIO
N 

No Identifies version of OPC 
being used by server.  

Connection Status GWOPCCONNST
ATUS 

No Shows current connection 
status.  

Connection Status 
String 

GWOPCCONNST
R 

No Shows applicable 
connection status string.  
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Viewing Statistics tab 

The following table summarizes the parameter data you can monitor on the Statistics tab 
of the Parameters form for the selected OPC Gateway block. See Monitoring OPC 
Gateway Status through Control Builder for details on accessing the OPC Gateway block 
Parameters form Statistics tab through the Monitoring tab. 

 
Plain Text Parameter Name User 

Configurable 
Notes 

Statistics Reset Flag GWSTATSRESET No  Lets user reset the statistics 
values.  

Responding to ACEs NUMACEOUTCON No Defines number of 
originator Application 
Control Environments 

OPC Server Status 

Active Parameters GWOPCPARAMCNT No View Only 

Data Change Rate GWOPCDCPS No View Only 

Store Rate GWOPCSTOREPS No View Only 

Read Errors GWOPCGETERR No View Only 

Store Errors GWOPCSTOREERR No View Only 

CDA Statistics 

Total Responder 
Rate 

NUMPARRSPAVG No View Only 

Peer Responder Rate CPEERAVGPPS No View Only 

Display Responder 
Rate 

CDISPAVGPPS No View Only 

Push/Store 
Response Rate 

NUMACCRQUAVG No View Only 

Notifications Rate NUMNTFRQUAVG No View Only 

Max Total Responder 
Rate 

NUMPARRSPMAX No View Only 

Max Peer Responder CPEERMAXPPS No View Only 
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Plain Text Parameter Name User 
Configurable 

Notes 

Rate 

Max Display 
Responder Rate 

CDISPMAXPPS No View Only 

Max Push/Store Rate NUMACCRQUMAX No View Only 

Max Notifications 
Rate 

NUMNTFRQUMAX No View Only 

 
Viewing Version tab 

The Version tab is common to all Parameters forms for tagged blocks in Control 
Builder. If you have a Qualification and Version Control System (QVCS) license, this tab 
shows current QVCS information for the selected OPC Gateway block. Please refer to 
the online help and the Qulification and Version Control Sytem User’s Guide for more 
information about the data on this tab. See Monitoring OPC Gateway Status through 
Control Builder for details on accessing the OPC Gateway block Parameters form 
Version tab through the Monitoring tab. 

Viewing Server History tab 
The Server History tab is common to all Parameters forms for tagged blocks in Control 
Builder. The following table summarizes the parameter data you can monitor on this tab 
of the Parameters form for the selected OPC Gateway block. See Monitoring OPC 
Gateway Status through Control Builder for details on accessing the OPC Gateway block 
Parameters form Server History tab in the Monitoring tab. 

 

 
ATTENTION 

The configuration settings you make for Server Load Options on the System 
Preferences dialog determines whether or not the data entered on the 
Server History tab is loaded to the Experion Server. See the Control 
BuildingGuide for information about setting system preferences.  

  
Plain Text Parameter Name User 

Configurable 
Notes 

Access Levels 

Control Level SCANCTRLLVL Yes Indicates Server control 
level to be associated with 
this function.  
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Plain Text Parameter Name User 
Configurable 

Notes 

History Configuration 

Number of History 
Parameters 

HIST.NUMPARAMS Yes Defines number of history 
parameters to be included 
in History Configuration 
table.  

Parameter  Yes Valid parameter name for a 
parameter associated with 
the given point that is to be 
collected and stored as 
historical data at 
predetermined intervals. 

Description  No Provides a brief description 
of the entered parameter.  

FAST  Yes Select the Fast type of 
history collection. 

STD  Yes Select the Standard type of 
history collection 

EXTD  Yes Select the Extended type of 
history collection 

Gating Parameter  Yes Optional gating parameter 
to define conditions under 
which data for this 
parameter should be 
collected. 

Gate State  Yes Defines gate state for 
configured gating 
parameter.  

Create New or Edit 
Existing Server 
Scripts (Button) 

 N/A Launch the Server scripting 
configuration utility.  
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Viewing Server Displays tab 

The Server Displays tab is common to all Parameters forms for tagged blocks in 
Control Builder. The following table summarizes the parameter data you can monitor on 
this tab of the Parameters form for the selected OPC Gateway block. See Monitoring 
OPC Gateway Status through Control Builder for details on accessing the OPC Gateway 
block Parameters form Server Displays tab in the Monitoring tab. 

 

 
ATTENTION 

The configuration settings you make for Server Load Options on the System 
Preferences dialog determines whether or not the data entered on the 
Server Displays tab is loaded to the Experion Server. See the Control 
Building Guidefor information about setting system preferences.  

  
Plain Text Parameter Name User 

Configurable 
Notes 

Point Detail Display SCANPNTDTL Yes By default, a Display 
template is already entered 
into Point Detail Display 
box (for example, 
sysDtlOPCA.dsp). This 
template can be used for 
creating your own display 
or it can be used as is, 
provided that your function 
block name matches name 
built into detail display that 
is supplied as a template. 

Group Detail Display SCANGRPDTL Yes By default, a Display 
template is already entered 
into the Group Detail 
Display box (for example, 
sysGrpOPCA.dsp). This 
template can be used for 
creating your own display 
or it can be used as is, 
provided that your function 
block name matches name 
built into detail display that 
is supplied as a template 

Associated Display SCANASSOCDSP Yes Name of the Server display 
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Plain Text Parameter Name User 
Configurable 

Notes 

to be associated with this 
function block. 

Trends 

Number of Trends TREND.NUMPARAM
S 

Yes Defines the number of trend 
parameters to be included 
in the Trends Configuration 
table. 

Trend #  Yes Defines Trend number to 
be associated with this 
trend parameter 

Pen  Yes Defines color of pen that 
will be used to trace 
assigned parameter on 
Station Trend display. 

Trend Parameter  Yes Valid parameter name for a 
parameter associated with 
given point that is 
configured for history 
collection.  

Description  No Provides a brief description 
of the entered parameter. 

Groups 

Number of Groups GROUP.NUMPARAM
S 

Yes Defines the number of 
group parameters to be 
included in Groups 
Configuration table.  

Group #  Yes Defines Group number to 
be associated with this 
group parameter.  

Pos #  Yes Defines number of position 
configured parameter will 
occupy in the Station Group 
display. 

Group Parameter  Yes Valid parameter name for a 
parameter associated with 
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Plain Text Parameter Name User 
Configurable 

Notes 

the given point that is 
configured in the system.  

Description  No Provides a brief description 
of the entered parameter. 

 
Viewing Control Confirmation tab 

The Control Confirmation tab is common to all Parameters forms for tagged blocks in 
Control Builder. If you have an optional Electronic Signature license, you can configure 
electronic signature information for the tagged block through this tab on the block’s 
Parameters form in Control Builder. Please refer to the online help and the Server and 
Client Configuration Guide for information about the data on this tab.  

The Electronic Signature function aligns with the identical Electronic Signatures function 
that is initiated through Quick Builder and Station for Server points. When this block is 
loaded to a controller, its control confirmation configuration (electronic signatures) is 
also loaded to the Server. This means you can view the control confirmation 
configuration for this tagged object in Station and also make changes to it. If you make 
changes through Station, you must initiate an Upload or Upload with Contents function 
through the Load/Upload menu in Control Builder for the object in the Monitoring tab 
to synchronize changes in the Engineering Repository Database (ERDB). 

Viewing Identification tab 
The Identification tab is common to all Parameters forms for tagged blocks in Control 
Builder. The following table summarizes the parameter data you can monitor on this tab 
of the Parameters form for the selected OPC Gateway block. See Monitoring OPC 
Gateway Status through Control Builder for details on accessing the OPC Gateway block 
Parameters form Identification tab in the Monitoring tab. 

 
Plain Text Parameter Name User 

Configurable 
Notes 

Name NAME Yes Unique block name 
consisting of up to 16 
characters to identify the 
block. At least one 
character in the name must 
be a letter (A-Z).  

Description DESC Yes Descriptive text appears on 
detail and group displays to 
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Plain Text Parameter Name User 
Configurable 

Notes 

uniquely describe this 
particular function block 

Block Comment 1 BLCKCOMMENT1 Yes Comment to be associated 
with this block consisting of 
up to 40 characters.  

Block Comment 2 BLCKCOMMENT2 Yes Comment to be associated 
with this block consisting of 
up to 40 characters.  

Block Comment 3 BLCKCOMMENT3 Yes Comment to be associated 
with this block consisting of 
up to 40 characters.  

Block Comment 4 BLCKCOMMENT4 Yes Comment to be associated 
with this block consisting of 
up to 40 characters.  

Library  No Identifies Control Builder 
Library that is source of 
template. 

System Template  No Identifies System Template 
that is source for this block.  

Base Template  No Identifies Base Template 
that is used for this block. 

Created By CREATEDBY No Identifies user who created 
block, if operator security is 
implemented. Otherwise, 
may just show Default 
login. 

Date Created DATECREATED No Shows date and time 
template was created. If 
this block is in Version 
Control System, shows 
date and time initial version 
of template was created. 

Last Modified By MODIFIEDBY No Identifies user who made 
last modifications to block, 
if operator security is 
implemented. Otherwise, 
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Plain Text Parameter Name User 
Configurable 

Notes 

may just show default login. 
If this block is in Version 
Control System, 
modifications apply to last 
version of block.  

Date Last Modified VERSIONDATE No Shows date and time last 
modification was made to 
block's configuration. If this 
block is in Version Control 
System, modification date 
and time applies to last 
version of block.  

 
Viewing Diagnostics tab 

The Diagnostics tab on the Parameters forms for OPC Gateway blocks in Control 
Builder lets you choose the parameters you want to monitor. You just type the name of 
the desired parameter in a row in the Parameter Name column in the Parameter Status 
grid on the tab. The OPC Gateway reports the parameter status as well as any error 
conditions. See Monitoring OPC Gateway Status through Control Builder  for details on 
accessing the OPC Gateway block Parameters form Diagnostics tab in the Monitoring 
tab. 

 
Plain Text Parameter Name User 

Configurable 
Notes 

Parameter Name GWOPCPMONNAME Monitoring 
Only 

Specify name of parameter 
to be checked.   

Status Code GWOPCPMONERR No Identify current status.  

Error String GWOPCPMONSTR No Show applicable error data.  

OPC Quality GWOPCPMONQUAL No Relative quality of OPC 
data.   
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Viewing EEGateway tab 

The following table summarizes the parameter data you can monitor on the EEGateway 
tab of the Parameters form for the selected OPC Gateway block. See Monitoring OPC 
Gateway Status through Control Builder for details on accessing the OPC Gateway block 
Parameters form EEGateway tab through the Monitoring tab. 

 
Plain Text Parameter Name User 

Configurable 
Notes 

EEGateway Status 

EEGateway State EEGSTATE No Check current Gateway 
state.   

Total number of 
reads 

TOTALNUMPOINTSR
EADS 

No View Only 

Number of succesful 
reads 

NUMPOINTSREADS No View Only 

Number of succesful 
writes 

TOTALNUMGETITEM No View Only 

Number of active 
items 

NUMACTIVEPOINTS No View Only 

Connected clients NUMCLIENTCONN No View Only 

Initiating Statistics 

Initiating to CPMs NUMCPMINCON No View Only 

Initiating to FIMs NUMFIMINCON No View Only 

Initiating to IOLIMs NUMIOLMINCON No View Only 

Initiating to ACEs NUMACEINCON No View Only 

Initiating to SCEs NUMSCEINCON No View Only 

Initiating to 
SIMIOLMs 

NUMSIOLMINCN No View Only 
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Viewing Peer Communications Tab 
The following table summarizes the parameter data you can monitor on the Peer 
Communications tab of the Parameters form for the selected OPC Gateway block. See 
Monitoring OPC Gateway Status through Control Builder for details on accessing the 
OPC Gateway block Parameters form Peer Communications tab through the 
Monitoring tab. 

 
Plain Text Parameter Name User 

Configurable 
Notes 

Initiator Connections 

Target Name IPEERNAME No View Only 

Target Path IPEERPATH No View Only 

Connection Status IPEERCONNSTS No View Only 

Connection Error 
Code 

IPEERCONNERRCO
DE 

No View Only 

Extended Error Info IPEERCONNERRINF
O 

No View Only 

Responder Connections 

Average Get Rate CPEERAVGPPSCON
N 

No View Only 

Maximum Get Rate CPEERMAXPPSCON
N 

No View Only 

Average Store Rate CPEERAVGSPSCON
N 

No View Only 

Maximum Store Rate CPEERMAXSPSCON
N 

No View Only 

Degraded Messages RPEERDEGIMRCON
N 

No View Only 
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Viewing Display Communications Tab 

The following table summarizes the parameter data you can monitor on the Display 
Communications tab of the Parameters form for the selected OPC Gateway block. See 
Monitoring OPC Gateway Status through Control Builder for details on accessing the 
OPC Gateway block Parameters form Display Communications tab through the 
Monitoring tab. 

 
Plain Text Parameter Name User 

Configurable 
Notes 

Responder Connections 

Average Get Rate CDISPAVGPPSCONN No View Only 

Maximum Get Rate CDISPMAXPPSCONN No View Only 

Average Store Rate CDISPAVGSPSCONN No View Only 

Maximum Store Rate CDISPMAXSPSCONN No View Only 

Degraded Messages RDISPDEGIMRCONN No View Only 
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Migration Considerations 
This section reviews things you should consider when migrating a pre R210 system with 
ACE and previous OPC Server block to an R210 system with ACE and OPC Gateway 
block.  

Migrating One ACE Node 
Prerequisites 

You have used the Export/Import function to migrate pre-R210 ACE node to R210 level.  

Considerations 
You must configure the OPC Gateway to specify the IP address for the computer hosting 
the OPC Gateway before you can load the block. See the Creating OPC Gateway Block 
procedure in this section for details about setting the Host IP Address.    

Migrating Multiple ACE Nodes 
Prerequisites 

You have used the Export/Import function to migrate all pre-R210 ACE nodes to R210 
level.  

Considerations 

• In systems with multiple ACE nodes, we recommend that you set the host IP address 
for the OPC Gateway to one of the following.  

− If one node is already doing OPC communications, set the Host IP Address for the 
OPC Gateway to that node to save DCOM configuration time. 

− If the OPC Server resides on the same node as an ACE, set the Host IP Address of 
the OPC Gateway to that node to save DCOM configuration time. 

See the Creating OPC Gateway Block procedure in this section for details about setting 
the Host IP Address  
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Migrating Some ACE Nodes 
Prerequisites 

You have used the Export/Import function to migrate some but not all pre-R210 ACE 
nodes to R210 level.  

Considerations 
If you leave one or more ACE nodes in a system at pre-R210 level, OPC references 
loaded to the ACE from the R210 level will be subscribed to at the OPC Gateway. The 
references loaded to a pre-R210 ACE will be handled by creating a new pre-R210 OPC 
Client within the CDA-sp memory space and connecting directly to the OPC server as 
shown in the following illustration.   

 

 
 

Figure 5  Mixing R210 ACE with Pre-R210 ACE 

In this case, the OPC Gateway may not reflect the status of the pre-R210 OPC Client 
operating in a pre-R210 ACE and should not be relied upon for that purpose.  

You must still set the host IP address for the OPC Gateway as outlined in the previous 
considerations in this section.  
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Maintenance and Troubleshooting 

Making IP Address or PROGID Change in Loaded OPC 
Gateway 

Use the steps in the following procedure to change the host IP address for the OPC 
Gateway, the host IP address for the OPC server, or the PROGID for the OPC server for 
a loaded OPC Gateway.  

Prerequisites 
You have logged on to Control Builder with sufficient privileges to make changes in a 
Control Strategy.  

Considerations 
• Be sure you evaluate any potential impact on the process before taking a loaded OPC 

Gateway offline and reloading it with revised configuration data.  

• Be sure all strategies using the OPC Gateway as a peer data source are in IDLE or 
unloaded state.  

• It may be a good idea to initiate a Checkpoint save of the OPC Gateway before 
making any configuration changes just in case you would need to restore it to its 
current condition.  

• If you change the host IP address for the OPC Gateway, be sure you reload any 
Control Modules or Sequential Control Modules that contain references to the OPC 
Gateway to refresh the communications path.  

 
Step Action 

1 On the Monitoring tab, click the icon for the OPC Gateway block you want to 
change.   

2 On the Controller menu, click Inactivate>Selected Item(s). 

3 • Wait for the OPC Gateway icon to turn blue.  

• On the Edit menu, click Delete.   

4 • Click the Project tab.  

• Double-click the icon for OPC Gateway block you just deleted in the 
Monitoring tab.  
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Step Action 

5 On the Main tab of the Parameters form, click in the field for the desired 
OPC Gateway Location or OPC Server Location parameter that you want to 
change. Type the new value. See Creating OPC Gateway Block for more 
information.  

6 Click the OK button to save the change and close the Parameters form.  

7 With the OPC Gateway block still selected in the Project tab, click Load on 
the Controller menu.  See Enabling OPC Gateway Simulation Supportfor 
more information.   

8 Once the block load is completed, click the Monitoring tab.   

9 Check that the loaded OPC Gateway is in its Idle state (icon is blue). 

10 On the Controller menu, click Activate>Selected Item(s) to return the OPC 
Gateway to operation.  

11 This completes the procedure.  
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Upgrading OPC Gateway Software to New Release 
Use the following procedure to update an operating OPC Gateway to a new software 
release.  

Prerequisites 
• You have received the new OPC Gateway software release installation media and 

instructions.  

• Prepare the process involving the OPC Gateway to be taken offline. 

• You have logged onto Control Builder with sufficient privileges to load a Control 
Strategy.  

Considerations 
• The following procedure assumes that the OPC Gateway block requires no 

configuration changes.   

• It may be a good idea to initiate a Checkpoint save of the OPC Gateway before 
installing the new software.  

 
Step Action 

1 On the Monitoring tab, click the icon for the OPC Gateway block that 
represents the OPC Gateway that is being updated to a new software 
release.  

2 On the Controller menu, click Inactivate>Selected Item(s). 

3 • Wait for the OPC Gateway icon to turn blue.  

• On the Edit menu, click Delete.   

4 Install the new OPC Gateway software on its hosting node following the 
instructions provided with the software. .  

5 Click the Project tab.  

6 Click the icon for the OPC Gateway block that was deleted in Step 3. On the 
Controller menu, click Load. See Enabling OPC Gateway Simulation Support 
for more information.  

 Once the block load is completed, click the Monitoring tab.   
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Step Action 

7 Check that the loaded OPC Gateway is in its Idle state (icon is blue). 

8 On the Controller menu, click Activate>Selected Item(s) to return the OPC 
Gateway to operation.  

9 Re-load any Control Modules or Sequential Control Modules that were 
affected by the update.  

10 This completes the procedure. 
 

Identifying and Fixing Common Problems 
This section lists some possible problems you may encounter in using the OPC Gateway 
along with some possible solutions for fixing them.  

 
If Problem Is . . .  Then, Possible Cause is . . .  And, Possible Solution Is . . . 

The OPC Gateway icon 
turns Red,   

Loss of Communications 
with Controller event is 
triggered, and 

Control strategies 
dependent on OPC 
Gateway for supervisory 
control shed to their 
configured backup 
modes.  

The node hosting the OPC 
Gateway has lost power.  

1.  Restore power to the node 
hosting the OPC Gateway.  

2.  Re-start the hosting 
computer.  

3.  Logon and launch Control 
Builder.  

4.  On Monitoring tab, select 
OPC Gateway block.  

5.  On Controller menu, click 
Restore from Checkpoint.  

6.  On Controller menu, click 
Activate>Selected Item(s), if 
OPC Gateway mode is IDLE.  

7.  Restore any control 
strategies that are dependent 
on the OPC Gateway.  
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If Problem Is . . .  Then, Possible Cause is . . .  And, Possible Solution Is . . . 

The OPC Gateway icon 
turns Red,   

Connection Timeout or 
Loss of Communications 
with Controller event is 
triggered, and 

Control strategies 
dependent on OPC 
Gateway for supervisory 
control are set to their 
failsafe values marked 
with BAD status.  

Failure of the CDA-sp service. 1.  Re-start the hosting 
computer.  

2.  Logon and launch Control 
Builder.  

3.  On Monitoring tab, select 
OPC Gateway block.  

4.  On Controller menu, click 
Restore from Checkpoint.  

5.  On Controller menu, click 
Activate>Selected Item(s), if 
OPC Gateway mode is IDLE.  

6.  Restore any control 
strategies that are dependent 
on the OPC Gateway.  

1.  On Monitoring tab, select 
OPC Gateway block.  

2.  On Controller menu, click 
Restore from Checkpoint.  

3.  On Controller menu, click 
Activate>Selected Item(s), if 
OPC Gateway mode is IDLE.  

The OPC Gateway icon 
turns Yellow,   

Connection Timeout 
event is triggered, and 

Control strategies 
dependent on OPC 
Gateway for supervisory 
control are set to their 
failsafe values.  

OPC Gateway process crashes.  

Check the Windows Event 
Log for any related critical 
error listings and take 
appropriate action.  
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If Problem Is . . .  Then, Possible Cause is . . .  And, Possible Solution Is . . . 

The active OPC 
Gateway icon is not 
Green, 

Connection to OPC 
Server Failed event is 
triggered, and 

Control strategies 
dependent on OPC 
Gateway for supervisory 
control are set to their 
failsafe values marked 
with BAD status.  

• Failed communications 
media connection including 
pulled cables, damaged 
cables, or hub/switch failures. 

• Failure of OPC server 
component.  

• OPC Gateway process 
crashes.  

• Check health of 
communication cables 
and secure connections. 
Repair as required.  

• Be sure the PROGID of 
the server that the 
OPCGateway is trying to 
connect to is available. 
(Either the PROGID 
needs to be in the local 
registry or the 
OPCGateway must be 
able to read the registry 
of the node it is trying to 
connect to.) 

• Check OPC server per 
manufacturer’s 
instructions.  

• See row above for 
details.  

• Check Event Handling 
logs for logged OPC 
Gateway related 
messages.  
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